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Power Button Click the power button to put the computer to
sleep. Restarting takes less time upon ‘waking up.’

Lock (icon) Locks the computer at the login screen. Only you
can unlock it.

Switch User Allows someone else to work in their own account
while you are logged in.

Log Off Saves all your work, closes programs, and returns
to login screen.

Restart Exits Windows, clears computer memory, then
restarts Windows

Shut Down Exits Windows and powers off computer.

Keyboard S
CTRL+ X Cut the selected object/text.
CTRL+ C Copy the selected object/text.
CTRL+V Paste the selected object/text.
CTRL+ A Select all objects.
CTRL+Z Undo the last operation.
ALT+ TAB Switch between opened windows.
Windows Key Opens the Start Menu.
CTRL+P Opens the Print dialog box.
CTRL+B Makes selected text bold.
CTRL+1 Italicizes selected Text.
CTRL+U Underlines selected text.
CTRL+HorF1 Opens the Help File.

Search Anytime, Anywhere

Start Button

Task bar

System Tray

Desktop

Recycle Bin

The blue button at the bottom left corner with the Windows logo. Click this to
display the Start menu.

Any programs with open windows are displayed here. Click a program button
to view the program on top of the other windows or restore a minimized
window.

Programs that are open have a border around them, and multiple instances of
the same program appear to have a stacked icon:

In the lower-right corner is the System Tray. Any background services or
program notifications are displayed as an icon in this location. Also visible is
the clock.

The main area in Windows where icons, program windows, and dialog boxes
appear. Your desktop picture can be modified to display nearly any picture
type.

A part of the Windows system that holds files that are marked for deletion, but
which can be recovered if necessary. Once the Recycle in is emptied, the files
can no longer be recovered by conventional means.

Using Click and Drag

The Start menu, every folder, and many programs contain a

Position your mouse over the thing you are going to interact with, press and hold the left




search bar that lets you search the current folder for your
criteria.

mouse button, and then move your mouse. You will drag the item along as you move your
mouse pointer.

7
IR TR L T
[a] .

he quick brown fox jumped over the lazy dog.

I |Search programs and files

Windows Aero Desktop H Using the Action Ce|+ter

Aero Snap Click and drag a title bar to the top of the screen to maximize it. If you run into problems when using your computer, chances are the Action Center will
Click and drag to the left or right screen, then release the mouse help detect at least the cause of the problem. The Action Center can also highlight the
button to make the window fill % of the screen. important things you need to look after in order to keep your computer in good

working order. Click the flag icon in the System Tray for an overview of computer

Aero Peek If many windows are open at once, move your mouse on top of issues:
the taskbar icon for the program you want to view. A pane of
thumbnails will appear. Hover over a thumbnail and all other
windows will become transparent, showing you that particular ‘w 1important message
window. 2 total messages

Aero Shake Click and shake a window title bar and all other windows will Find an antivirus program online (Important)
minimize to the taskbar. Shake the same title bar again and all Change Windows Update settings
other windows will be restored to their original size.

Jump Lists Right-click an icon on the taskbar to see commonly-used files Open Action Center
and program features. You can also start a new instance of a
program and close multiple programs of the same kind at once.

Jump Lists are also visible if you attempt to click and drag an
icon up and off the taskbar.
K i K . . Click Open Action Center to open and view the items that need your attention.

Flip3D Press Wm, + Tab to cycle through all open Wme\_NS (.lncludlng the Items in Red are serious issues that you should look into right away. Items in Yellow are
desktop) in 3D. Release the Tab key at your destination. important issues that are not critical but should be looked after.

Windows 7 File Structure \

Desktop

Internet Explorer 7 Commands :

T Libraries ) (Your Name) ‘k:‘ S @" i SyaemFoloe '!: Reycatia
M:_'J System Folder & System Folder S Systern Folder - System Folder Sl Systern Folder ::ﬁ System Folder
“|Documents iContacts &L Local Disk (C)) Other Computers System and Security I Items to be deleted
;’?Music jmDesktop ~=Floppy Disk Drive (A:) | Media Devices Network and Internet
= Pictures @ Downloads L2DVD RW Drive (D:) Network Infrastructure Hardware and Sound
ﬁ\h’deos LFavorites Programs
#Plinks User Accounts and Family Safety
I My Documents Appearance and Personalization
WMy Music Clock, Language, and Region
& My Pictures Ease of Access
HMy Videos
#Saved Games
/Searches
1. Tracing

Tips and Tricks

Back and
Forward

Retrace your steps backwards (left-facing

Right-click: Click your right mouse button on any object (including the desktop) to open a pop-up menu.

arrow) or forwards (right arrow).

Address Bar

Open a file or folder: To open a file or folder, double-click on the icon.

Click and type a Web site address.




Refresh Reloads the current Web site from the host Create a folder: To create a folder, right-click on the desktop and select New = Folder from the right-

server. click menu.
Stop Stop loading the current Web site. Rename a file or folder: To rename a file or folder right-click on the file or folder icon and select Rename
from the popup menu.
Search Bar Click in the Search Bar, type a word or phrase,
and press Enter to search. Delete a file or folder: To delete a folder or file, right-click on the folder or file you want to delete and
select Delete from the menu.
Toolbar Standard tools include a button to return to
home page, print, manage options, etc. What'’s this?: Hold your mouse pointer over a button or icon for a second and you will be given a

description of what that button does.

Minimize, Maximize, and Restore 4‘—

Minimize - Hides a window on the Maximize - Expands a window to fill the entire ﬂi Restore - Returns a maximized window to its initial
—=| taskbar. screen. size.
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1: File Menu

Click the File button to view the Backstage menu.
(Backstage)

2: Quick Access This specialized toolbar provides quick access to the commands you use most often.
Toolbar

3: Title Bar

4: Window
Controls

The name of the current folder, your mailbox, and the program name will appear here.
From left to right, these are the Minimize, Maximize/Restore, and Close commands.



5: Minimize the
Ribbon/Help
Icons

6: Tabs
7: Groups

8: Navigation
Pane

9: Search Box

10: Working
Area

11: Reading
Pane

12: To-Do Bar
13: People Pane

14: Status Bar

Click the small up arrow on the right-hand side of the window to minimize or expand the
ribbon. Click the blue question mark icon to open the Help dialog.

Click a tab name to view commands specific to that name.

The commands on each tab are separated into groups. Sometimes, in the bottom right-hand
corner of a group, you will see an option button. Click this button to see additional commands
related to the group.

This pane is the easiest way to get around in Outlook. It contains links to various folders so that
you can easily view your contacts, mail, calendar, and more.

Use this area to search for items.

Here is where you can see the contents of the selected folder. Here, we can see new mail
because we’re in the inbox.

View the contents of the selected item here.

This bar is visible in all folders except the Calendar folder. It summarizes upcoming tasks and
appointments.

Summarizes Outlook information, RSS feeds, status updates, and other social networking
information about the person referenced in the currently selected item.

Displays item count for the current folder as well as view controls.

Keyboard  Action Often, if someone is sending a long document or a file that
Combination can’t be copied and pasted into an e-mail message, they will
Cirl + N C : | attach the file itself. You can tell if a file is attached by the
tri+ f rI((ejate a ne,zw |_tem (relevant to paperclip icon in the message list. If you look at the message
older you're in) in the Reading Pane, you will see that a file is attached.
Alt+S Send your e-mail or save and close
your Item oge by el " e St T Tu;:;::r:':rsi:r:‘::::.-\anris:@-inbon.corn-
Ctrl+S Save your e-mail/item o ezt
Ctrl+R Reply to an e-mail ¢ o o e
Ctrl + P Open the Print area Of the File E:‘::;?ﬂ:‘l:':‘::"(nm : Could \«Dl:r(\v::‘w this presentation for me and ket me know what you think?
menu

Ctrl + Shift Create a folder

+E

4 Last Month

8 bve wedcast series, ask the exper... Sue

Ctrl + Shift  Use the Outlook Address Book You can right-click the file to see options.

+B



Ctrl + Shift  Create a contact Training Presentation

+C Susan Harris <susan.harris@inbox.com>
© You forwarded this message on 4/30/2010 9:26 AM
Fl Get Help Mon 4/26/2010 10:24 AM
F3or Ctrl + Go to the search box b
| Message iﬂ'ﬁal ing New Employees.pptx (1 MB)
E & Preview
F9 Send/receive e-malil Hello Sam, & Open
F11 Find a contact Could you review t E S:l:k_ flmt et me know what you think?
s SaveA
Ctrl +1 Go to Mail View Thank you! G) save All Attachments...
. X Remove Attachment
Ctrl +2 Go to Calendar View Sue )
- 5 y
Ctrl +3 Go to Contacts View B2 SelectAll
Ctrl+4 Go to Tasks View
Ctrl +5 Go to Notes View Or, if you click to select the attachment, you will see the
o Attachment Tools tab:
Ctrl+6 Go to Folder List View
Ctrl+7 Go to Shortcuts View
Ctrl + 8 GO tO Journal VleW LZ  Home Send / Receive Folder View Attachments
~~ L\ = @.). :_I 31
el &y X =30 &
Open Quitk Save Save All Remove Select Copy Show
Print As  Attachments Attachment All Message
Conversations are a new way of looking at Actions Selection | Message
messages in Outlook 2010. They group messages
together by subject, even if different people are
involved in the conversation. Conversations can be
identified by the small triangle at their top level.
You can use this triangle to expand or collapse the ) .
conversation: At the bottom of the calendar, you will see a pane listing
tasks that are due on each day. (You set this due date when
By DRE IR e p— z you create tasks.) This replaces the TaskPad feature available
in previous versions of Outlook.
¥ Yesterday
4 Monday
(3 Training Presentation 0] 60 [Faasy Dlense
Susan Harris Mon 10:24 AM
4 (Celebrating Joe's Retirement - - =
g Kim MacKay Mon10:17AM | , ey
* g Kim MacKay Mon 9:57 AM

You can add, edit, and monitor tasks using this pane. There is
also a contextual tab available when you are working with the
Daily Tasks List.

In this conversation, we can see that the first
message was received by Kim. Then, we responded
(the Sam Smith entry in italics). Kim replied back
to us. (Conversation messages are always sorted by
date and time, with the newest one on top.)



Conversations organize messages even if those
messages are in different folders. (The message we
sent, for example, is in the Sent Items folder.)

You can toggle conversation grouping on or off
with the Conversations group on the View tab and
the Arrange By menu. And, the Conversation
Settings menu on the View tab allows you to
customize how conversations are displayed.
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1: File Menu
(Backstage)

2: Quick Access
Toolbar

3: Title Bar
4: Window Controls

5: Tabs

6: Minimize the

Click the File button to view the Backstage menu.

This specialized toolbar provides quick access to the commands you use most often.

The name of the document will appear here, as well as the program name.
From left to right, these are Minimize, Maximize/Restore, and Close.

Click a tab name to view commands specific to the tab name. For example, the Page
Layout tab lets you change the paper size, margins, paragraph settings, and more. The
command area under the tabs is known as the ribbon.

Click the small up arrow on the right-hand side of the window to hide the ribbon. Click




Ribbon and Help
Icons

7: Groups
8: Working Area

9: Scroll Bar

the blue question mark icon to open the Help dialog window. We will explore the Help
file later in this manual.

The commands on each tab are separated into groups.
Here is where you will type the contents of the document.

The scroll bar lets you browse through your document. Click the up/down arrow at each
end of the scroll bar to move in that direction, or click and drag the scroll marker to
move quickly through the document. If your mouse is equipped with a wheel, rotate the

10: Status Bar

the current zoom level.

One of the most exciting new features in Office 2010 is the ability to
customize the ribbon.

To Start: Click File = Options and then click Customize Ribbon.

Customize the Ribbon: (i

To Show a Tab: Ensure that it has | MainTabs ~]
a checkmark in the list on the right. e
- ain 1abs
Note that some tabs will only be l [¢] Home
visible under certain conditions. @ []Insert
- R [ |¥|Page Layout
(For example, Outlining will only 1 [V] References
be visible in Outline view.) — ;’::'L’\‘f‘
# ;J;\"lew
To Hide a Tab: Remove the < rhe
checkmark from the list on the [ [7 Blog Post
H ® [V]Insert (Blog Post)
“ght' # [V] Outlining

1 [¥] Background Removal
To Rearrange Items: Select an
item and then click the up or down arrows.

To Reset All Tabs: Click Reset > Reset all customizations. This will
remove all custom tabs and groups. Note that this will also reset the
QAT as well.

wheel up or down to scroll. Also note that if you have zoomed into your document and
the width of the page exceeds the width of the Word window, you will see a horizontal
scroll bar appear just about the status bar. Use this to scroll from side to side.

The status bar provides information about the document. It shows which page or pages
are visible, how many words the document has, what view is currently being used, and

To Create a Tab:

1. Click New Tab.

2. Click Rename.

3. Choose an icon, type a name, and
press Enter.

4. Click New Group.

5. Rename the group using Steps 2 and
3.

6. Choose a command from the list on
the left.

7. Click Add. Use the arrows to
rearrange commands if desired.

8. Repeat Steps 4 to 7 until you have
added all desired commands.

New Group l [ Rename...
Import/Export ¥ |

To Delete a Tab: Select the tab from the list
on the right and click <<Remove to delete it
permanently.

NewTab |

Customizations:




SmartArt

Pane

Simultaneous
Online

Tips and Tricks for Selecting Text

v"If you have a block of text selected and you

start typing, the selected text will be replaced
by your new text.

You can select a block of text and drag and
drop it into anywhere in your document. You
can also use the navigation pane to move
large amounts of text.

You can select any level of text (letter, word,
phrase, paragraph, page, document, or parts
thereof) and manipulate it. This means you
can bold a single letter the same way you
would an entire document.

You can double-click a word to select it.
Triple-click to select the whole paragraph.

If you want to delete a portion of text, you
can select it and hit either the Backspace or
Delete keys on your keyboard rather than
cutting it.

You can select different parts of text by
selecting the first part, holding the Ctrl key
with your mouse, and selecting another part.
You can select a large portion of text by
selecting the first word, holding the Shift
key, and selecting the last word.

To deselect text, just click anywhere in your
document.

Selecting Text with the Keyboard

Select a letter to the left of your cursor

Select the letter to the right of your
cursor

Select text from your cursor to the
beginning of a word

Select text from your cursor to the end
of a word

Select from your cursor to one line
above

Select text from the position of your
cursor to one line below

Select text from your cursor to one page
above

Select text from your cursor to one page
below

Select text from your cursor to the
beginning of the line

Select text from your cursor to the end
of the line

Select text from your cursor to the
beginning of the paragraph

Select text from your cursor to the end
of the paragraph

Select an entire document

Shift + Left
Arrow

Shift + Right
Arrow

Ctrl + Shift +
Right Arrow

Ctrl + Shift + Left
Arrow

Shift + Up Arrow

Shift + Down
Arrow

Shift + Page Up

Shift + Page
Down

Shift + Home
Shift + End

Ctrl + Shift + Up
Arrow

Ctrl + Shift +
Down Arrow

Ctrl + A

New Features in Word 2010

Expanded

Navigation

SmartArt lets you create professional-looking diagrams very easily. There are many new
types of SmartArt in Word 2010.

Word 2010 includes a new feature called the navigation pane. This is a special task pane that
appears on the side of the screen. It lets you quickly navigate through your document,

rearrange content by dragging and dropping, view each page of the document as a thumbnail
(small image), and search the document.

Editing

Many programs in Office 2010, including Word, are capable of using an online collaboration
tool called SharePoint. In a nutshell, SharePoint allows you to share documents and
information with coworkers via a central server, usually set up by your IT department. Word




2010 uses this to allow many people to work on the same document at the same time.

Backstage In the upper left-hand corner of the screen, you will see a tab marked File. Click this tab to
view the Backstage menu. This menu gives you quick access to management commands for
your document. You can save, print, share, and modify background properties of your
document all in one place.

Streamlined  Printing in previous versions of Word required opening a separate dialog box in order to
Printing change features like paper size, collation, number of copies, etc. Now all print commands and
a true-to-scale preview are accessible in the Backstage menu.

PDF Support Word 2010 has native save support for PDF files without needing to download any additional
software.

Integrated Word 2010 gives you the option to insert an image of any open window or a rectangular
Screen screenshot that you define by clicking and dragging.
Capture




Microsoft Office®

Excel

Foundation
Quick Reference Guide

Interacting with Excel

Home Insert

2 Page Layout Formulas Data Review View ~ @ = |
B % poerre o -[-] E¢ General - [FjcConditional Formatting + S=lnset+ E - AT ﬂ
3 d i G- EESH $-% + [EromatasTable- $XDelete [~ A
Paste B I U~ - | & 5 . Sort & Find &
- & e2 EEE | 2 8 % () Cent Stytes - [EiFormat - | 2~ Fifter~ Select*
Clipboard 1. ] Alignment %| MNumber Styles Celis Editing
4 Al v (=

o e w N

1. Quick Access

Toolbar

Customize this toolbar
with commonly-used
commands.

. Tabs

Name for each
category of commands
in Excel.

. Ribbon commands

Commands for each
tab are displayed here.

. Name Box

Shows name/cell
reference of currently
selected cell; active
cell.

. Formula Bar

Enter formulas or
change cell content.

. Working Area

The cells that make up
the current worksheet.

. Workbook Tabs

Name for each
worksheet in a




workbook file.

8. Status Bar
Shows vital statistics
about file or selected
range of data.

9. Scroll Bars
Scroll horizontally or
vertically through
your data here.

Saving a Workbook ‘Parts of a Workbook

When working with files in Excel, you will either save a new file A | B | ¢ | b <= Columns
that was made from scratch or save changes to an existing file. = ,mdm T
Save Save As - :::333:
New You will be promptedto  You will be ? Ym/'
File give the file a name and prompted to give the Cells
choose a save location. file a name and Rows
You can also specify a file choo:_se asave Each workbook contains one or more
type. location. Y ou can worksheets. Switch between worksheets with
also specify afile these tabs:
type. -
Existin  Any changes you made You have the option HEIEEN] Sheat1 (SHAe2'Z Stiacts <18
g File  will be applied to the to give the file a new e
existing file in its current  name and/or a new
location. save location. You

can also specify a
new file type. If you
do change
something, the
original existing file
will not be changed.

Cut (Ctrl + X): Removes dataand Copy (Ctrl + C): Creates a copy of Paste (Ctrl + V): Places

stores it on the clipboard. the source data and stores it on the  Cut/Copied information back into
clipboard. The source data remains  file at insertion point. Cut items
untouched. usually paste once, Copied items




Printing
Click File = Print. All print options are available on
the left, and a scaled version of your file, with the

selected paper and layout settings, is shown on the
right. Click the large Print button when ready:

o Print
il

Print

Copies 1 - e
- e
- .

=~

Printer

 Bullzip POF Prirter =
Prnte: Propetmes - ..

Settings

Print Actrve Sheets &
Ondy print the active sheets

- aw owm

Pages: - to

jJEDII_.'.d . l

123 123 123

1 Portrait Orientation

J Letter
85" x11°
HNearnal Marging
i Left: 0 Right: 0.7

] No Sealing
188 Print sheets at thear actus] &

Eage Setup
11 oft »

Oy

Creating/ Editing Charts

The better formatted your data, the easier it will be
for Excel to create the chart for you. Select the
source data as well as associated row/column
headers:

| A | &8 | ¢ |
1 Sales Profits
2 |North $32,149.00 | $6,429.80
i South $23,847.00 | $4,769.40
4 [East $12,092.00 | $2,418.40
5 |West $ 6,612.00 | $1,322.40

Click the Insert tab and choose the chart type. Excel
will then insert the chart:

multiple times.

AutoFill, AutoSu

AutoFill will complete lists of repeating or incremental
data. Enter two incremental numbers, select them, and

then click and drag the small black square in the lower

right-hand corner.

, AutoComplete

Year

1

S-SR REY - TV S R

S

Year
1990

l@

= -

1996
1997
1998

AutoSum can automatically generate the sum of all
numerical data above or to the left of the current cell.
Click Formulas = AutoSum:

DOLLAR v (© X ¢ f| =sum(B2:84)
| A [ | c | b E

1 Testl  Test2  Test3

2 Day1 6586] 5843 7898

3 Day2 9215; 4587 6745

4 Day3 | 1241 4785 4523
5] =SUM(

6 . SUM(number1, [number2], ...) |

AutoComplete examines the data that you have already
typed in your worksheet and an automatically fill in what
it thinks you are typing, based on what you type. For
example, If you enter the name Alice and then start to type
Alice again, Excel will automatically complete the rest of
the name for you:

Alice
Alice
Arnold




I

South | $23,847.00 | $4,769.40 - — = —
East $12,092.00 | $2,418.40
$ 6,612.00 | $1,322.40

= North
o South
WEast
-West

Excel will show three contextual tabs that give full
control over different aspects of your chart:

e || e |”

Contextual tabs disappear when you deselect a chart,
reappear when you reselect it.

s-;jw N, O Uiick Calculations in Status Bar

If you select some data, Excel will automatically calculate
the average, show how many items have been selected,
and calculate the sum:

4] A B | ¢C D | E |

1 1

2 Test1 Test 2 Test 3

3 Day 1 87 29 59
|4 Day 2 21 65 23

) Day 3 38 51 94

5| 2

M <> M| Sheetl Sheet2 . Shest3 \;‘E_J e

Ready | o3 | Average: 51.88888389 Count: 9 Sunu_ml_

Note that this data might not make sense, depending on
what you select!
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PowerPoint

Foundation

Quick Reference Guide

The PowerPoint Interface

|

Click tolaﬁj title

9
C.Iick tb add subtitle
| -
Click to add notes 1 1
ﬂn""iﬁi}ﬁﬁo' | Engiun U5) |[BlE ez e

.

1 - File Menu (Backstage
View): Similar to the File
menu in older versions.

2 - Quick Access Toolbar:
Provides quick access to the
commands you use most
often.

3 - Title Bar
4 - Window Controls

5 - Minimize the Ribbon
and Help Icons

6 - Tabs: Click a tab name
to view commands specific
to that name.

7 - Groups: The commands
on each tab are separated
into groups.

8 - Slides/Outline Pane:
Shows either thumbnails or
a text outline of your slides.

9 - Rulers
10 - Working Area: Here

is where you will create
your presentation.




11 - Notes Area: You can
add notes to each slide in
this area.

12 - Status Bar

Adding Content to Slides

To add text to a slide, simply click where indicated and type: Click a placeholder icon to add that
content type:

Click to add title. ~ |icon | Content Type
| Table

!’ id Chart

: SmartArt (diagrams)
Introduci nd ° | Picture from your computer

e - ] ClipArt (pictures that come
with Office)

Audio or video clips

Changing the Theme

By default, all blank presentations use the Office theme. (Templates may use
different themes, or even a custom theme.) To change the theme, click a thumbnail
in the Themes gallery. Or, click the More arrow to view the entire collection of A %E
themes. Each theme is customizable with the drop-down menus to the right of the . g
gallery. The Colors, Fonts, and Effects commands each open a drop-down menu,

allowing you to choose a style for that element.




Keyboard Shortcuts

Creating Your Own Tabs

Enter

Open a new presentation | Ctrl + N 1. Click File - Options. = sy
- 2. Click Customize Ribbon. H
Save a flle Ctl’| + S 3 Click NEW Tab_ . hi{](ms‘t;?rm Position
Open a file Ctrl + 0 4. Click Rename. A foxcin
- - 5. Name the tab and click OK. L A
Print a presentation Ctrl +P 6. Click New Group.
Close PowerPoint Alt + F4 7. Choose an icon, name the group, and click OK.
8. Add commands to the group.
Select all Cul+A 9. Repeat steps 6 — 8 to add all desired commands.
Copy text Ctrl+C 10. Click OK in the PowerPoint Options dialog.
Cut text Ctrl + X ot o HE e
Paste text Ctrl +V [ e &) customizethe ibbon
Find text Ctrl + F soe . = R — =
Align text to center Ctrl + E & fasimmsion A
Align text to left Ctrl + L PS— 1,!”:'"3": ' i
Align teXt to right Ctrl + R ;ustCenter i‘ :'::H L =31} F;:psnunmr?rmanmmcmloml
A Decrease Font Size 1 . J.m;r:nlmcmom
Justify text Ctrl +J  pmcsentcsion Sl
Increase font size Ctrl + Shift + . A Fca il = —
W Format Background... ‘ .J:;i:‘:m’ﬂ
Increase font size Ctrl + Shift +, 3 okt @ B aceim
Undo last action Ctrl+Z é g :EL‘MM
Redo last action Ctrl +Y b o [eBeene
0 Hew | Nmm | [ MewGroup | [ Rename.. |
Check spelling or grammar |F7 5 open Cotomesiors: (SRRSO
&l Open Recent File... Import/Export ¥ |
Get he|p Fl | ) ..:—a"'—J
Start presentation from F5 ) )
Slide 1 Using the Format Pal%ter
Start presentation from Shift + F5 The Format Painter allows you to copy formatting from one
current slide object and apply it to another object. To start, select the text with
Next slide or animation . NorEnter the formatting that you want to copy. Then, click thg Format
e Page Down Painter icon on the Home tab or on the mini toolbar:
e Right arrow
e Down arrow
e Spacebar
Previous slide or animation |* P
e Page Up
e Leftarrow
e Up arrow
e Backspace
Go to a particular slide <number> +




Go to first slide Home
Go to last slide End
End slide show Esc
Display black screen B
Display white screen W

When the text box is selected, you can use
the Drawing Tools — Format tab to
modify your text box.

You can click a pre-formatted style in the
Shape Styles group or click the More
arrow and choose from the gallery:

You can also use the Fill, Outline, and
Effects menus to change those individual
aspects of the text box.

To apply special effects to the text in the
box, use the pre-formatted styles or the
individual menus in the WordArt Styles
group of the Drawing Tools — Format tab.

Formatting Text Boxes
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Now, select the text that you want to apply the formatting to:




